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ABSTRAK 

Pemanfaatan teknologi dalam konteks Smart Home semakin berkembang pesat, memberikan 

solusi pintar untuk meningkatkan kenyamanan dan efisiensi energi di dalam rumah. Salah satu 

aspek krusial dalam Smart Home adalah pengendalian suhu ruangan. Proposal merancang dan 

mengimplementasikan sistem Smart Home pemantauan dan pengendalian suhu ruangan 

menggunakan Arduino ESP32 berbasis green energy. Penggunaan panel surya sebagai sumber 

energi pada sistem  menawarkan pendekatan berkelanjutan, mengurangi ketergantungan pada 

sumber daya energi konvensional. Arduino ESP32 digunakan sebagai otak sistem untuk 

mengintegrasikan sensor suhu, panel surya, dan mekanisme pengendalian, menciptakan solusi 

yang cerdas dan ramah lingkungan. Metodologi penelitian melibatkan perancangan dan 

implementasi perangkat keras serta perangkat lunak. Sistem  memungkinkan pemantauan suhu 

ruangan secara real-time dan kontrol otomatis berdasarkan data yang dikumpulkan. Eksperimen 

dilakukan untuk mengevaluasi kinerja sistem dalam mengoptimalkan suhu ruangan dengan 

memanfaatkan energi panel surya. 

Kata kunci: Arduino ESP32, Efisiensi Energi, Panel Surya, Rumah Pintar, Suhu Ruangan 

 

ABSTRACT 

The utilization of technology in the context of Smart Homes is rapidly advancing, providing 

smart solutions to enhance comfort and energy efficiency within homes. One crucial aspect of 

Smart Homes is temperature control. This proposal aims to design and implement a Smart Home 

system for monitoring and controlling room temperature using Arduino ESP32 based on green 

energy. The use of solar panels as the energy source for this system offers a sustainable 

approach, reducing reliance on conventional energy resources. The Arduino ESP32 is employed 

as the system's brain to integrate temperature sensors, solar panels, and control mechanisms, 

creating an intelligent and environmentally friendly solution. The research methodology involves 

the design and implementation of both hardware and software. This system allows real-time 

monitoring of room temperature and automatic control based on the collected data. Experiments 

are conducted to evaluate the system's performance in optimizing room temperature by utilizing 

solar panel energy. 

Keywords: Arduino ESP32, Energy Efficiency, Solar Panel, Smart Home, Room Temperature. 

 

PENDAHULUAN 

Perkembangan teknologi dalam beberapa dekade terakhir telah mengubah cara 

kita mengelola dan mengendalikan berbagai bagian rumah kita. Konsep rumah pintar, 

juga dikenal sebagai Smart home, adalah salah satu inovasi yang semakin populer. 

Smart home memanfaatkan teknologi untuk memantau, mengontrol, dan 
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mengotomatisasi berbagai sistem dan perangkat dalam rumah, dengan tujuan 

meningkatkan kenyamanan, efisiensi energi, dan keamanan. 

Salah satu defsi dari "Internet of Things (IoT)" adalah bagaimana perangkat 

elektronik yang kita gunakan setiap hari, seperti smartphone, TV, internet, dan sensor, 

dihubungkan ke internet, yang memungkinkan mereka berkomunikasi satu sama lain 

secara bersamaan, yang memungkinkan manusia berkomunikasi dengan digital (Susilo 

et al., 2021). Pemanfaatan IoT dapat  diterapkan  pada perangkat  untuk smarthome 

dengan memanfaatkan Arduino dan ESP32  dengan teknologi IoT (Wicaksono & 

Rahmatya, 2020).  Pemanfaatan teknologi IoT membutuhkan suatu konektivitas internet 

yang kuat dan fasilitas yang memadai. Penerapan IoT perlu dioppenulisalkan di segala 

aspek kehidupan (Lasera & Wahyudi, 2021).  

Banyak rumah tangga mengalami kesulitan dalam mengatur suhu ruangan secara 

efisien dan ramah lingkungan, sementara sistem konvensional kurang fleksibel dan 

tidak mampu menyesuaikan pengaturan suhu secara otomatis. Kebutuhan akan solusi 

rumah pintar semakin meningkat, Salah satu komponen penting dari rumah pintar 

adalah sistem pemantauan dan pengendalian suhu. Pengendalian suhu yang tepat 

menghemat energi dan meningkatkan kenyamanan. Panel surya juga menjadi lebih 

populer sebagai sumber energi alternatif karena mereka dapat mengurangi 

ketergantungan kita pada energi fosil dan mengurangi dampak mereka terhadap 

lingkungan. Selain itu, alat pendingin ruangan seperti AC dapat mengontrol suhu di 

dalam ruangan. Kondisi suhu ruangan yang tidak sesuai khususnya untuk penyimpanan 

barang atau peralatan dapat mempercepat rusaknya peralatan atau barang yang terdapat 

pada ruangan tersebut. Oleh karena itu perlu adanya sistem pemantau suhu ruangan dan 

pengendali alat pendingin ruangan yang praktis, efisien dan dapat dimonitor dari jarak 

jauh (Vinola & Rakhman, 2020).  

Arduino ESP32 adalah platform perangkat keras yang populer untuk 

pengembangan sistem berbasis Internet of Things (IoT) dan memiliki kemampuan WiFi 

dan Bluetooth yang memungkinkan berkomunikasi nirkabel dengan berbagai perangkat. 

Penggunaan Arduino ESP32 dalam proyek  memberikan fleksibilitas dan konektivitas 

yang diperlukan untuk memonitor dan mengendalikan suhu ruangan secara cerdas. 

Penilaian kualitas kinerja sistem dari waktu ke waktu dikenal sebagai monitoring. 

Kegiatan sehari-hari perusahaan termasuk pemantauan yang dilakukan secara teratur. 

Dapat disimpulkan bahwa monitoring adalah proses pengumpulan informasi secara 

berkelanjutan yang bertujuan untuk dapat    mengawasi kegiatan yang telah dilakukan 

guna meningkatkan penyempurnaan tujuan yang ingin di capai (Fortuna & Zakaria, 

2022).  

Energi dihasilkan oleh sel surya dari cahaya matahari. Di tengah-tengah kondisi 

lingkungan yang padat penduduk dan suhu yang cukup panas di siang hari, penggunaan 

alat  sangat cocok.  Faktor alat dan biaya yang diperlukan untuk membuat dan 

memasang alatnya membuatnya sangat terjangkau bagi masyarakat.  Panel surya juga 

tidak menimbulkan efek gangguan atau kerusakan lain pada objek maupun keadaan  di 

sekitar  alat tersebut,   karena   hanya   terdapat   satu   buah   panel   surya.   Sehingga 

tidak penggunaan panel surya menimbulkan efek rumah  kaca  (Jaenul et al., 2022). 

 Dengan menggunakan Arduino ESP32, tujuan penelitian adalah membuat dan 

menerapkan sistem yang menggunakan energi panel surya untuk memantau dan 

mengendalikan suhu ruangan dalam rumah pintar. Sistem ini bertujuan untuk memantau 

suhu ruangan secara otomatis, mengoppenulisalkan jumlah energi yang digunakan panel 
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surya, dan memberikan pengaturan suhu yang nyaman dan efisien bagi penghuni rumah. 

Tujuan dari proposal adalah sebagai berikut: 1. Menghasilkan karya ilmiah yang 

berkualitas tinggi yang memenuhi persyaratan untuk mendapatkan gelar Strata satu 

(S1). 2. Merancang dan mengembangkan sistem pemantauan suhu ruangan yang cerdas 

dan otomatis berbasis Internet of Things (IoT). 3. Mengintegrasikan panel surya sebagai 

sumber energi untuk mengurangi ketergantungan pada sumber energi konvensional 

dalam pengoperasian sistem. 4. Menyediakan kemudahan yang dapat diakses secara 

jauh untuk memantau, mengatur, dan mengubah preferensi. 

 Penelitian akan memberikan beberapa manfaat yang signifikan, antara lain: 1. 

Sistem akan meningkatkan kenyamanan penghuni rumah dengan memungkinkan 

pengaturan suhu yang lebih cerdas dan responsif. Penghuni akan dapat mengatur suhu 

sesuai keinginan mereka, menciptakan suasana yang lebih nyaman.2. Penggunaan panel 

surya sebagai sumber energi akan mengurangi ketergantungan pada sumber energi fosil, 

mengurangi emisi karbon, dan mendukung upaya perlindungan lingkungan. 3. Proposal 

ini akan mendorong pengembangan teknologi Internet of Things (IoT) dalam konteks 

rumah pintar. Peluang untuk pengembangan perangkat cerdas di masa depan dapat 

meningkat sebagai hasil dari inovasi ini.4. Sistem akan memiliki kemampuan untuk 

secara otomatis merespon perubahan suhu ruangan, mengurangi intervensi manusia, dan 

memastikan suhu ruangan tetap dalam kisaran yang nyaman. 5. Sistem akan 

mengintegrasikan data dari sumber luar, seperti suhu udara luar. 

 

TINJAUAN PUSTAKA  

 Internet of Thing atau IoT adalah sebuah istilah yang dimaksudkan dalam 

penggunaan internet yang lebih besar, mengadopsi komputasi yang bersifat mobile dan 

konektivitas kemudian menggabungkannya ke dalam kehidupan sehari-hari. IoT 

berkaitan dengan DoT (Disruption of Things) dan sebagai pengantar perubahan atau 

transformasi penggunaan internet dari sebelumnya Internet of People menjadi Internet 

of M2M (Maching-toMachine) (Natsir et al., 2019). 

 Smart home adalah sebuah konsep rumah cerdas yang memanfaatkan teknologi 

secara maksimal, dengan kontrol terpusat untuk mengendalikan dua atau lebih sistem 

individu yang bertujuan meningkatkan efesiensi, kenyamanan dan keamanan (Awal, 

2019). 

 Arduino  ESP32 merupakan salah satu modul IoT yang worth-it digunakan. 

memungkinkan peralatan elektronik dengan teknologi lama maupun peralatan 

elektronik dengan kategori entry level untuk melakukan komunikasi melalui network. 

Peralatan teknologi sekarang tentunya sudah banyak yang teritegrasi dengan wifi, 

namun peralatan yang lama belum didukung dengan fasilitas wireless networking  

(Wikantama & Puspitasari, 2023). 

 Teknik Prototype sering digunakan  ketika  pemilik  sistem  tidak  begitu  

mengetahui  sistem  yang  akan dikembangkan, sehingga diperlukan gambaran tentang 

sistem yang akan dikembangkan. Prototipe bukan sesuatu yang lengkap, tetapi perlu 

dievaluasi kembali dan diperbaiki. Perubahan dapat terjadi ketika prototype dibuat 

untuk memenuhi kebutuhan pengguna, membantu pengembang lebih memahami 

kebutuhan pengguna (Hakim et al., 2023). 
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Penelitian Yang Relevan 

 Rancang Bangun Alat Monitoring Suhu Menggunakan Sensor DS18B20 Dan 

Pengaduk Otomatis Pada Proses Fermentasi Kakao Oleh Maulana Fahar Maheswara 

membahas rancang bangun alat monitoring suhu menggunakan sensor DS18B20 dan 

pengaduk otomatis pada proses fermentasi kakao. Alat ini menggunakan mikrokontroler 

ESP-32 dan Node MCU ESP-32, serta sensor suhu DS18B20. Output data dapat dilihat 

pada website platform IoT dan disimpan ke dalam MicroSD.(Maheswara, 2023) 

 Rancang Bangun Rumah Pintar (Smart Home) Berbasis Internet Of Things (IoT) 

Oleh Malik Ibrahim & Bambang Sugiarto membahas tentang rancang bangun rumah 

pintar berbasis Internet of Things (IoT) menggunakan NodeMCU sebagai penghubung 

antara hardware dan software yang dikontrol melalui web. Sistem ini dapat 

dikendalikan dari jarak jauh, memonitor sensor asap dan api, serta memberikan 

notifikasi ke pengguna jika terjadi hasil pengukuran yang di atas ambang batas.(Ibrahim 

& Sugiarto, 2023) 

 Sistem Kontrol Kelembaban Dan Temperatur Pada Ruang Tanaman Hidroponik 

Berbasis Web Rohma Septi Wulansari & Novita Wahyu Setyawati membahas tentang 

sistem untuk memantau dan mengontrol suhu dan kelembaban di rumah kaca untuk 

tanaman hidroponik. Sistem ini berbasis IoT dan menggunakan sensor dan 

mikrokontroler untuk mengatur suhu dan kelembaban, dengan data ditampilkan pada 

antarmuka web. (Wulansari & Setyawati, 2019) 

 

METODE PENELITIAN 

Model Prototype 

 Pada penelitian ini menggunakan metode prototyping. Prototype merupakan 

metodologi pengembangan perangkat lunak berupa model fisik sistem sebagai fungsi 

awal dari sistem tersebut. 

 Dalam pembuatan Prototype peneliti menggunakan metode Prototype, adapun 

langkah - langkah untuk mengimplementasikan metode tersebut yaitu sebagai berikut : 

1. Quick Plan 

 Kami akan menentukan kebutuhan fungsional dan non-fungsional sistem, 

termasuk suhu ruangan yang diinginkan, monitoring suhu real-time, dan integrasi 

dengan panel surya. Alur kerja sistem ESP32 akan dirancang untuk membaca data suhu 

dari sensor, mengatur perangkat pemanas atau pendingin, dan mengelola suplai energi. 

Komponen keras yang digunakan meliputi sensor suhu DHT22, modul komunikasi IoT, 

dan library Arduino untuk kontrol suhu dan manajemen energi. 

2. Modeling Quick Design 

 Desain sistem mencakup interaksi antar komponen utama seperti Arduino 

ESP32, sensor suhu DHT22, panel surya, baterai, pendingin ruangan, modul pengendali 

daya, dan aplikasi smartphone/tablet. Arduino ESP32 berfungsi sebagai pengendali 

utama, sensor DHT22 untuk pemantauan suhu, panel surya untuk energi, baterai untuk 

penyimpanan, pendingin untuk pengaturan suhu, modul daya untuk distribusi energi, 

dan aplikasi untuk kontrol dan pemantauan real-time. 

3. Construction of Prototype 

 Prototype fisik dirangkai sesuai desain, menggunakan Arduino ESP32, sensor 

suhu DHT22, panel surya, baterai, pendingin ruangan, dan modul pengendali daya. 

Kode program untuk Arduino ESP32 ditulis untuk membaca data suhu, mengendalikan 

pemanas atau pendingin, dan berkomunikasi dengan panel surya. Modul komunikasi 



 
JUPITER   

Teknologi Informatika & Komputer  
Vol. 5 No. 2 Agustus  2024 

                                                                                                             Institut Bisnis Muhammadiyah Bekasi  
P-ISSN: 2798-3129 , E-ISSN: 2798-6187

 

105 

dihubungkan untuk koneksi IoT, memungkinkan pemantauan dan pengendalian sistem 

real-time melalui aplikasi smartphone/tablet. 

4. Deployment Delivery & Feedback 

 Setelah merancang sistem, langkah selanjutnya adalah menerapkannya pada 

ruangan smart home yang telah ditentukan. Kami akan melakukan uji sistem di kondisi 

nyata untuk memantau kinerjanya dan mengidentifikasi potensi perbaikan yang 

diperlukan. Kami juga akan aktif mencari umpan balik dari pengguna potensial dan ahli 

terkait untuk memastikan bahwa sistem sesuai dengan harapan dan memenuhi 

kebutuhan yang diinginkan. 

5. Communication 

 Sistem harus memastikan komunikasi yang efektif menggunakan protokol 

komunikasi yang sesuai, serta mempertimbangkan aspek keamanan data dan jaringan, 

termasuk enkripsi data yang dikirim atau diterima. Seluruh proses pengembangan, 

mulai dari desain, implementasi, pengujian, hingga perbaikan, didokumentasikan secara 

rinci dan disampaikan kepada pihak terkait untuk referensi dan pemeliharaan sistem. 

 

Tahapan Perancangan Sistem 

Perancangan sistem melibatkan perancangan blok alat dengan kemampuan 

mengontrol suhu ruangan menggunakan sensor DHT22 dan mikrokontroller. Gambar 1 

adalah detail perancangan sistem: 

 

 
Sumber: Hasil Penelitian (2024) 

Gambar 1. Diagram Perancangan Sistem 

 

Blok Diagram 

 Dengan blok diagram pada Gambar 2, panel surya mengisi baterai melalui solar 

charge controller, dan energi tersebut dapat digunakan untuk menggerakkan perangkat 

AC melalui inverter DC ke AC. ESP32 bertindak sebagai otak sistem yang 

mengendalikan sensor dan Relay  channel untuk mengoptimalkan penggunaan energi 

dan kenyamanan ruangan. Smartphone memberikan kontrol dan pemantauan eksternal. 
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Sumber: Hasil Penelitian (2024) 

Gambar 2. Blok Diagram 

 

Diagram Alur Sistem 

 Diagram alur dari sistem monitoring suhu yang menggunakan Relay  Shield 

untuk mengontrol arus listrik ke CPU berdasarkan suhu yang terdeteksi oleh sensor 

dimulai dengan simbol lingkaran yang menunjukkan titik awal dari alur proses. Setelah 

itu, sistem melakukan sialisasi yang mencakup pengaturan parameter awal, memulai 

komunikasi dengan sensor, dan mempersiapkan tampilan LCD. Selanjutnya, sistem 

melakukan pengecekan sensor suhu untuk membaca nilai suhu dari lingkungan dan 

mengirimkannya ke CPU untuk diproses. Nilai suhu yang telah dibaca kemudian 

ditampilkan pada layar LCD sehingga pengguna dapat melihatnya secara real-time.  

Pada tahap berikutnya, sistem memeriksa apakah suhu yang terbaca lebih dari 

30°C. Jika suhu lebih dari 30°C, Relay  Shield akan membuka arus listrik ke CPU dan 

mengaktifkan CPU untuk menjalankan tindakan yang diperlukan, serta menyalakan 

LED merah sebagai indikator bahwa suhu telah melewati batas yang ditentukan. Jika 

suhu kurang dari 30°C, sistem memeriksa apakah suhu kurang dari 30°C. Jika ya, Relay  

Shield akan menutup arus listrik ke CPU, yang berarti CPU akan dinonaktifkan atau 

dalam mode standby, dan LED merah akan dimatikan sebagai indikator bahwa suhu 

berada dalam batas aman.  

Diagram diakhiri dengan simbol lingkaran yang menunjukkan titik akhir dari 

alur proses. Setiap langkah di dalam diagram dihubungkan dengan panah yang 

menunjukkan arah alur proses, dengan titik keputusan ditandai dengan simbol berlian 

yang menunjukkan adanya percabangan berdasarkan kondisi suhu tertentu (suhu > 30°C 

atau suhu < 30°C). Tindakan yang diambil berdasarkan kondisi suhu disertai dengan 

penjelasan singkat mengenai fungsi Relay  Shield dan status LED, menggambarkan 

sistem yang efektif dalam memonitor dan mengontrol suhu serta memberikan umpan 

balik visual melalui LED merah. Sistem  dapat diaplikasikan dalam berbagai konteks, 

seperti industri, rumah tangga, atau laboratorium penelitian. 
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Sumber: Hasil Penelitian (2024) 

 

Gambar 3. Diagram Alur Sistem 

 

Perancangan Hardware 

 Pada perancangan prototipe yang dibuat ini, diperlukan beberapa komponen 

untuk menunjang sistem Internet of Things for Smart Home. Komponen yang 

diperlukan yaitu panel surya, Solar Charge Controller, aki, inverter, Arduino esp32, 

sensor dht22, lcd i2c 16x2, breadboard, kabel jumper, Relay  2 chanel, kabel, 

stopkontak. 

 
Tabel 1. Spesifikasi Alat 

No Tools Tipe 

1 Panel Surya Monocrystalline Silicon 

2 pengontrol charging baterai Solar Charge Controller 

3 Baterai Aki Kering 

4 Inverter Pure sine wafe 

5 MicroController Arduino ESP32 

6 Sensor DHT22 

7 Monitor LCD I2C 

8 Breadboard MB-102 Solderless Breadboard 400P 

9 Kabel Jumper Male to male, male to female 

10 Modul Penggerak Relay  5v 2 Channel Module 

11 Kabel Kabel Auto Solar Panel Surya PV-1F 

12 Stopkontak - 

 

 

HASIL DAN PEMBAHASAN 

Arsitektur Sistem 

Smart home adalah sebuah konsep di mana berbagai perangkat di dalam rumah 

terhubung dan dapat dikendalikan secara otomatis. Salah satu aspek penting dari smart 

home adalah sistem pemantauan dan pengendalian suhu ruangan. Sistem  dirancang 
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untuk menjaga kenyamanan penghuni rumah dengan mengatur suhu ruangan secara 

otomatis berdasarkan preferensi yang ditetapkan pada kondisi lingkungan. 

 
Sumber: Hasil Penelitian (2024) 

Gambar 4. Circuit Wiring  System 

 

Rangkaian sistem smart home  terdiri dari beberapa komponen utama, yaitu 

panel surya, pengendali muatan (charge controller), baterai, inverter, modul Arduino 

ESP32, sensor suhu dan kelembaban (DHT22), LCD display, Relay , dan kipas angin. 

Panel surya digunakan sebagai sumber energi utama dalam sistem , yang mengubah 

energi matahari menjadi energi listrik untuk mengisi baterai. Pengendali muatan 

bertugas untuk mengatur aliran listrik dari panel surya ke baterai, memastikan baterai 

tidak overcharge dan menjaga umur baterai agar lebih tahan lama. Baterai menyimpan 

energi listrik yang dihasilkan oleh panel surya, yang kemudian digunakan untuk 

menjalankan seluruh sistem ketika matahari tidak bersinar atau pada malam hari. 

Inverter digunakan untuk mengubah tegangan DC dari baterai menjadi tegangan AC 

yang dibutuhkan oleh perangkat elektronik di rumah, seperti kipas angin. 

Arduino ESP32 merupakan mikrokontroler yang menjadi otak dari sistem , 

menerima data dari sensor suhu dan kelembaban (DHT22), kemudian mengolah data 

tersebut untuk ditampilkan pada LCD display dan mengontrol Relay  yang terhubung 

dengan kipas angin. Sensor DHT22 mengukur suhu dan kelembaban ruangan dan 

mengirimkan data yang dihasilkan ke Arduino ESP32 untuk diproses lebih lanjut. LCD 

display digunakan untuk menampilkan informasi suhu dan kelembaban ruangan secara 

real-time, sehingga pengguna dapat memantau kondisi ruangan dengan mudah. Relay  

berfungsi sebagai saklar elektronik yang dikendalikan oleh Arduino ESP32, 

menghubungkan dan memutuskan aliran listrik ke kipas angin berdasarkan pengaturan 

suhu yang telah ditentukan. Kipas angin digunakan sebagai alat untuk mengatur suhu 

ruangan. Ketika suhu ruangan melebihi batas yang ditentukan, Arduino ESP32 akan 

mengaktifkan Relay  untuk menyalakan kipas angin dan menurunkan suhu ruangan. 

Sistem  memungkinkan pemantauan dan pengendalian suhu ruangan secara otomatis 

dan efisien menggunakan energi surya sebagai sumber daya utamanya. 
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Pembahasan 

 Panel surya adalah komponen utama yang menyediakan energi listrik untuk 

seluruh sistem pemantauan dan pengendalian suhu. Dalam sistem , panel surya 

berfungsi untuk mengonversi energi cahaya matahari menjadi energi listrik yang 

kemudian disimpan dalam baterai. Energi listrik yang dihasilkan panel surya digunakan 

untuk menjalankan mikrokontroler ESP32, sensor suhu, dan modul Relay  yang 

mengendalikan kipas angin. 

 
Sumber: Hasil Penelitian (2024) 

Gambar 5. Komponen Pembangkit Listrik Tenaga Surya 
 

Perancangan Arduino 

 Untuk merancang sistem Arduino, pertama-tama unduh Arduino IDE dari situs 

resmi arduino.cc, pilih versi yang sesuai dengan sistem operasi Windows Anda, dan 

ikuti instruksi untuk mengunduh dan menginstal file instalasi. Setelah instalasi selesai, 

buka Arduino IDE, dan tambahkan URL berikut di bagian Additional Boards Manager 

URLs melalui File > Preferences: https://dl.espressif.com/dl/package_esp32_index.json. 

Kemudian, buka Tools > Board > Boards Manager, cari "ESP32," dan klik Install pada 

entri "esp32 by Espressif Systems." Sambungkan ESP32 ke komputer menggunakan 

kabel USB, pilih board ESP32 yang sesuai (DOIT ESP32 DEVKIT VI) dari menu 

Tools > Board, dan pilih port serial yang terhubung dengan ESP32 melalui Tools > 

Port. Setelah instalasi dan konfigurasi selesai, langkah berikutnya adalah menulis dan 

mengunggah kode ke ESP32. 

1. Mekanisme Kerja Sistem 

 Dalam sistem , pengukuran suhu ruangan dilakukan secara kontinu oleh sensor 

suhu DHT22. Sensor  mengirimkan data suhu ruangan ke mikrokontroler ESP32 untuk 

diolah lebih lanjut. ESP32 kemudian membandingkan data suhu yang diterima dengan 

ambang batas yang telah ditentukan, yaitu 30°C. 

 Jika suhu ruangan yang terukur berada di atas 30°C, ESP32 akan mengirimkan 

sinyal tegangan rendah untuk mengaktifkan Relay. Relay berfungsi sebagai saklar 

elektronik yang dapat dikendalikan oleh ESP32. Ketika Relay aktif, sirkuit listrik akan 

tertutup, memungkinkan arus listrik yang disuplai dari baterai untuk mengalir ke stop 

kontak yang terhubung dengan kipas angin. Akibatnya, kipas angin akan menyala untuk 

membantu menurunkan suhu ruangan. 
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Sumber: Hasil Penelitian (2024) 

Gambar 6. Alat Berhenti Bekerja 
 

Sebaliknya, jika suhu ruangan turun di bawah 30°C, ESP32 akan mengirimkan 

sinyal untuk membuka Relay, memutus sirkuit listrik. Dengan demikian, arus listrik ke 

stop kontak akan terputus dan kipas angin akan mati. Sistem  memastikan bahwa kipas 

angin hanya beroperasi saat diperlukan, yaitu ketika suhu ruangan melebihi 30°C, 

sehingga penggunaan energi menjadi lebih efisien dan suhu ruangan tetap terjaga dalam 

batas yang nyaman. 

 
Sumber: Hasil Penelitian (2024) 

Gambar 7. Alat Mulai Menyala 

 

Uji coba (Prototype Testing) 

1. Pengujian Sistem Tenaga Surya 

Sistem tenaga surya diuji untuk memastikan bahwa panel surya dapat 

menghasilkan daya yang cukup untuk mendukung operasi sistem. Pengujian dilakukan 

pada berbagai kondisi cuaca. Hasil pengujian menunjukkan bahwa pada kondisi cuaca 

cerah, panel surya dapat menghasilkan daya sebesar 20W, cukup untuk mengoperasikan 
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sistem selama 12 jam. Pada kondisi mendung, daya yang dihasilkan berkurang menjadi 

10W, yang cukup untuk mengoperasikan sistem selama 6 jam. 
 

 
Sumber: Hasil Penelitian (2024) 

Gambar 8. Testing Panel Surya 

 

2. Pengujian Modul Wi-Fi ESP32 

Pengujian modul Wi-Fi ESP32 dilakukan untuk memastikan koneksi jaringan 

stabil dan data dapat dikirimkan ke server dengan baik. Pengujian dilakukan dengan 

menghubungkan ESP32 ke jaringan Wi-Fi lokal dan mengirimkan data suhu dan 

kelembapan setiap 10 detik. Hasil pengujian menunjukkan bahwa koneksi tetap stabil 

tanpa kehilangan paket data selama 24 jam pengujian. 

3. Pengujian Sensor Suhu dan Kelembapan 

Pengujian sensor suhu dan kelembapan dilakukan untuk memastikan bahwa 

sensor dapat membaca suhu dan kelembapan dengan akurat.  Hasil pengujian 

menunjukkan bahwa sensor DHT22 yang digunakan dalam sistem  memiliki tingkat 

akurasi yang tinggi, dengan deviasi rata-rata ±0,5°C untuk suhu dan ±2% untuk 

kelembapan. 
 

 
Sumber: Hasil Penelitian (2024) 

Gambar 9. Serial Monitor 
 

Hasil Penelitian 

Analisis Sistem Smart Home Pemantauan dan Pengendalian Suhu Ruangan 

 Setelah dilakukan pengujian secara komprehensif pada lingkungan Komplek 

Plebesit Raya RT 01 RW 05, terbukti bahwa alat yang kami rancang pada Gambar IV.3 

dan Gambar IV.4 dapat berfungsi dengan baik. Hal ini dibuktikan ketika suhu mencapai 
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ambang batas atas 30°C, maka alat pendingin ruangan akan hidup, dan ketika suhu 

ruangan di bawah 24°C, maka pendingin ruangan akan berhenti bekerja. 

 

PENUTUP 

Simpulan 

Penelitian  berhasil merancang dan mengimplementasikan sistem pemantauan 

dan pengendalian suhu ruangan dalam konteks smart home yang menggunakan sumber 

energi surya dan teknologi Arduino ESP32. Sistem  menawarkan solusi cerdas untuk 

meningkatkan kenyamanan penghuni rumah dan mengurangi ketergantungan pada 

sumber energi konvensional dengan cara yang berkelanjutan. Beberapa kesimpulan 

yang dapat diambil dari penelitian  antara lain: 

1. Pemanfaatan panel surya sebagai sumber energi utama terbukti efektif dalam 

menyediakan daya yang diperlukan untuk pengoperasian sistem pengendalian suhu, 

sehingga mengurangi penggunaan energi dari jaringan listrik konvensional. 

2. Sistem yang dikembangkan mampu memantau suhu ruangan secara real-time dan 

mengendalikan perangkat pendingin secara otomatis berdasarkan data yang 

dikumpulkan, memastikan kenyamanan optimal bagi penghuni rumah. 

3. Penggunaan Arduino ESP32 memungkinkan integrasi yang mudah dengan 

perangkat IoT lainnya, memberikan fleksibilitas dan kemampuan untuk 

mengendalikan dan memantau sistem dari jarak jauh melalui smartphone. 

4. Sistem  tidak hanya mendukung efisiensi energi tetapi juga berkontribusi pada 

pengurangan emisi karbon, mendukung siatif keberlanjutan lingkungan. 

 

Saran 

Berdasarkan hasil dan pembahasan dari penelitian, beberapa saran untuk 

pengembangan lebih lanjut adalah sebagai berikut: 

1. Menggunakan sensor suhu dan kelembaban yang lebih akurat dapat meningkatkan 

kinerja sistem dalam mengatur suhu ruangan. 

2. Mengembangkan sistem  agar dapat digunakan untuk mengontrol lebih banyak 

perangkat di dalam rumah, tidak hanya terbatas pada perangkat pendingin. 

3. Mengintegrasikan sistem dengan teknologi smart home lainnya, seperti sistem 

keamanan dan pencahayaan otomatis, untuk meningkatkan kenyamanan dan 

keamanan penghuni rumah. 

4. Melakukan pengujian sistem dalam jangka waktu yang lebih panjang dan dalam 

berbagai kondisi cuaca untuk memastikan keandalan dan kestabilan sistem. 

Penelitian  diharapkan dapat memberikan kontribusi positif bagi pengembangan 

teknologi smart home yang lebih efisien dan berkelanjutan di masa depan. Kritik dan 

saran dari pembaca sangat diharapkan untuk penyempurnaan penelitian  di masa yang 

akan datang. 
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